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 Important Information

Warranty
The FieldPoint hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the product, for precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and LED names.

cFP-21xx cFP-21xx refers to the cFP-2100, cFP-2110, and cFP-2120.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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1
Overview of Compact FieldPoint

This chapter provides an overview of the cFP-21xx Compact FieldPoint 
controller and FieldPoint software.

cFP-21xx Compact FieldPoint Controller Overview
Using the cFP-21xx controller with LabVIEW Real-Time provides an 
easy-to-use system for real-time embedded applications. When you run the 
LabVIEW Real-Time Engine on a cFP-21xx, the controller can run 
applications without a host PC. If you connect the cFP-21xx to an Ethernet 
network, you can use a separate host PC running Windows to display 
measurement results and status information and change the settings of the 
controller. Refer to the LabVIEW Help for more information about the 
LabVIEW Real-Time Engine.

Besides the Ethernet port, the cFP-21xx has one or more RS-232 serial 
ports accessible through software. It also has LED indicators to 
communicate status information and DIP switches that perform various 
functions. The cFP-2120 also has a software-accessible RS-485 port and 
switch input/LED output for connecting to external devices such as LED 
status indicators and start/stop buttons. Figure 1-1 shows where all of these 
features are located on the cFP-21xx. The figure indicates which features 
are available only on specific models such as the cFP-2120.
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Figure 1-1.  cFP-21xx Parts Locator Diagram

A Compact FieldPoint system consists of one cFP-BP-x backplane, one 
cFP-21xx controller, one or more I/O modules, and one or more connector 
blocks or accessories. Each Compact FieldPoint system can be accessed by 
an unlimited number of PCs and controllers, forming a distributed 
computing system. The maximum number of cFP-21xx controllers that you 
can install on an Ethernet network is limited only by network topology.

The cFP-21xx controller connects directly to a 10 or 100 Mbps Ethernet 
network. The cFP-21xx auto-detects the speed of the connection 
and configures itself accordingly.

1 Ethernet Port
2 RS-232 Serial Port
3 Removable Compact Flash (cFP-2120 Only)
4 LED Indicators
5 DIP Switches
6 Reset Switch

7 Power Connector
8 Switch Input/LED Output Terminals (cFP-2120 Only)
9 RS-485 Serial Port (cFP-2120 Only)
10 RS-232 Serial Port (cFP-2120 Only)
11 RS-232 Serial Port (cFP-2110 and cFP-2120)
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For detailed hardware specifications and cabling information, refer to 
Appendix B, Specifications.

FieldPoint Software Overview
FieldPoint software includes NI Measurement & Automation Explorer 
(MAX) as well as server and driver software for easy integration into 
application software packages. These software components manage 
the low-level communications and hardware details, simplifying 
programmatic access to I/O channels. FieldPoint software runs on 
Windows 2000/NT 4.0 Service Pack 6+/XP and includes the following 
components:

• MAX

• LabVIEW VIs

• LabWindows™/CVI™ Functions

• Measurement Studio instrument drivers

• OPC Server

• VI Logger support

You can download a current version of FieldPoint software from the 
National Instruments Web site. Using your Web browser, go to ni.com, 
select Support»Drivers and Updates»Current Software Versions»
Distributed I/O—FieldPoint, then select the latest version of 
NI-FieldPoint.

cFP-21xx Setup Overview
The following list is an overview of the steps required to get started with 
the cFP-21xx and LabVIEW Real-Time.

1. Install hardware as described in Chapter 2, Installing Compact 
FieldPoint Hardware and Software.

a. Mount backplane on a panel, DIN rail, or standard 19-in. rack.

b. Mount cFP-21xx and I/O modules on backplane.

c. Connect cFP-21xx to network.
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2. Install software as described in Chapter 2, Installing Compact 
FieldPoint Hardware and Software.

a. Install programming software (LabVIEW Real-Time).

b. Install FieldPoint software.

3. Configure Compact FieldPoint system and verify configuration as 
described in the Measurement & Automation Explorer Help for 
FieldPoint.

a. Configure cFP-21xx network settings.

b. Configure I/O module ranges and settings.

c. Configure security.

d. Connect input signals and loads to I/O modules.

e. Test channels.

f. Save settings.

4. Configure optional settings as described in Chapter 3, Feature 
Descriptions.

5. Develop application as described in Chapter 4, LabVIEW Real-Time 
Programming.

a. Launch LabVIEW Real-Time.

b. Build basic application.

c. Switch execution target to test application on cFP-21xx.

d. Embed application by building .exe with LabVIEW Real-Time 
targeted to cFP-21xx.

e. Test embedded application.

6. Deploy system.



© National Instruments Corporation 2-1 cFP-21xx and cFP-BP-x User Manual

2
Installing Compact FieldPoint 
Hardware and Software

This chapter explains how to install the Compact FieldPoint hardware and 
software.

What You Need to Get Started
To set up and use LabVIEW Real-Time with the cFP-21xx, you need the 
following:

❑ cFP-21xx Compact FieldPoint controller

❑ cFP-BP-x backplane

❑ Mounting hardware (DIN rail, panel-mount, or rack-mount accessory)

❑ cFP I/O module(s)

❑ Wiring accessories such as cFP-CB-x connector block(s) or cables

❑ 11–30 VDC power supply (20 W recommended)

❑ Ethernet cable

❑ 1/8 in. flathead and number 2 Phillips screwdrivers

❑ NI-FieldPoint software version 4.1.1

❑ A host PC running Windows 2000/NT 4.01/XP

❑ LabVIEW Real-Time software

1   Using FieldPoint software with Windows NT 4.0 requires Service Pack 6 or later.



Chapter 2 Installing Compact FieldPoint Hardware and Software

cFP-21xx and cFP-BP-x User Manual 2-2 ni.com

❑ Optional accessories

– 37-pin I/O cables

– Serial cables

– DIN-rail terminal blocks

Compact FieldPoint Safety Information
The following section contains important safety information that you must 
follow when installing and using Compact FieldPoint products.

Do not operate the Compact FieldPoint product in a manner not specified 
in the user manual or operating instructions. Misuse of the product can 
result in a hazard. You can compromise the safety protection built into the 
product if the product is damaged in any way. If the product is damaged, 
return it to National Instruments for repair. 

Do not substitute parts or modify the Compact FieldPoint product. Use the 
product only with the modules, accessories, and cables specified in the 
installation instructions. 

You must connect the protective earth (PE) ground terminal on the 
cFP-BP-x backplane to the system safety ground. The backplane PE ground 
terminal has the following symbol stamped beside it: . Connect the 
backplane PE ground terminal to the system safety ground using 14 AWG 
(1.6 mm) wire with a ring lug. Use the 5/16 in. panhead screw shipped with 
the backplane to secure the ring lug to the backplane PE ground terminal.

Do not operate Compact FieldPoint products in an explosive atmosphere or 
where there may be flammable gases or fumes. If you need to operate 
Compact FieldPoint products in such an environment, the Compact 
FieldPoint products must be in a suitably rated enclosure. 

If you need to clean a Compact FieldPoint product, use a soft nonmetallic 
brush. The product must be completely dry and free from contaminants 
before you return it to service.

Operate the product only at or below Pollution Degree 2. Pollution is 
foreign matter in a solid, liquid, or gaseous state that can reduce dielectric 
strength or surface resistivity. The following is a description of pollution 
degrees:

• Pollution Degree 1 means no pollution or only dry, nonconductive 
pollution occurs. The pollution has no influence.
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• Pollution Degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused 
by condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs which becomes conductive due to 
condensation. 

Caution You must insulate signal connections for the maximum voltage for which the 
Compact FieldPoint product is rated. Do not exceed the maximum ratings for the product. 
Do not install wiring while the product is live with electrical signals. Do not remove or add 
connector blocks when power is connected to the Compact FieldPoint system. Avoid 
contact between your body and the connector block signal wiring when hot-swapping 
modules.

Operate Compact FieldPoint products at or below the installation category1 
marked on the hardware label. Measurement circuits are subjected to 
working voltages2 and transient stresses (overvoltage) from the circuit 
to which they are connected during measurement or test. Installation 
categories establish standard impulse withstand voltage levels that 
commonly occur in electrical distribution systems. The following is a 
description of installation categories:

• Installation Category I is for measurements performed on circuits not 
directly connected to the electrical distribution system referred to as 
MAINS3 voltage. This category is for measurements of voltages from 
specially protected secondary circuits. Such voltage measurements 
include signal levels, special equipment, limited-energy parts of 
equipment, circuits powered by regulated low-voltage sources, and 
electronics.

• Installation Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 
refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (for example, 115 V for U.S. or 230 V for Europe). 
Examples of Installation Category II are measurements performed on 
household appliances, portable tools, and similar products.

• Installation Category III is for measurements performed in the building 
installation at the distribution level. This category refers to 
measurements on hard-wired equipment such as equipment in fixed 

1   Installation categories, also referred to as measurement categories, are defined in electrical safety standard IEC 61010-1.
2   Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.
3   MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably rated measuring circuits may 

be connected to the MAINS for measuring purposes.
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installations, distribution boards, and circuit breakers. Other examples 
are wiring, including cables, bus-bars, junction boxes, switches, 
socket-outlets in the fixed installation, and stationary motors with 
permanent connections to fixed installations.

• Installation Category IV is for measurements performed at the primary 
electrical supply installation (<1,000 V). Examples include electricity 
meters and measurements on primary overcurrent protection devices 
and on ripple control units.

Mounting the Compact FieldPoint Backplane
You can mount the cFP-BP-x backplane on a panel or in a standard 19 in. 
rack. You can mount the cFP-BP-4 on a 35 mm DIN rail. The following 
sections contain instructions for all three mounting methods. Before using 
any of these mounting methods, record the serial number from the back of 
the backplane. You will be unable to read the serial number after you have 
mounted the backplane.

To ensure maximum cooling efficiency, mount the Compact FieldPoint 
system so that the I/O module vents are at the top and bottom.

Figure 2-1.  cFP-BP-4 Backplane Properly Mounted

Caution As you mount the backplane, keep in mind the following requirements for space 
and cabling clearance:

• Allow 51–76 mm (2–3 in.) all around the backplane for air circulation.

• Allow 76 mm (3 in.) in front of the controller and 38 mm (1.5 in.) below the controller 
for cabling clearance.

Up
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Figure 2-2.  cFP-BP-x Backplane with cFP-21xx Installed,
Bottom View with Dimensions

Figure 2-3.  cFP-BP-x Backplane with cFP-21xx Installed, Front View with Dimensions
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(5.00 in.)

Cabling
Clearance

Min 165 mm
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Caution NI recommends that you use one of the mounting systems described in this 
document. If you decide to use a custom mounting solution, make sure that the screws 
you use are short enough to fit in the holes in the backplane. The screw holes are 5 mm 
(0.2 in) deep.

Mounting the Backplane on a Panel
The cFP-BP-x backplane is shipped with a panel-mount kit. Complete the 
following steps to mount the backplane on a panel:

1. Fasten the two plates of the panel-mount kit to the back of the 
cFP-BP-x using a number 2 Phillips screwdriver and the 
8-32 × 5/16 in. countersink screws shipped with the kit. These 
screws have a nylon coating to prevent them from loosening. Refer to 
Figures 2-4 and 2-5.

Caution Do not use screws longer than 5/16 in. to fasten the panel-mount plates to the 
backplane.

Figure 2-4.  Fastening the Panel-Mount Plates to the cFP-BP-4 Backplane

2. Bolt or screw the panel-mount accessory to a panel using 8-32 or 
M4 screws.

 NATIONAL 

INSTRUMENTS
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Figure 2-5.  The cFP-BP-4 Backplane with Panel-Mount Accessory

Figure 2-6.  The cFP-BP-8 Backplane with Panel-Mount Accessory

3. Connect the safety ground as explained in the Compact FieldPoint 
Safety Information section.

Caution Disconnect power before removing the backplane from the panel.

Note As shown in Figures 2-5 and 2-6, the horizontal panel-mount kit shipped with the 
backplane extends about 3/4 in. from each side of the backplane. NI also offers a vertical 
panel-mount kit that extends from the top and bottom of the backplane and is flush with 
the sides. The vertical panel-mount kit is part number 778688-01.

102 mm
(4 in.)

260.4 mm (10.25 in.)

279 mm (11.0 in.)

127 mm 
(5.0 in.)

102 mm 
(4.0 in.)

457 mm (18.0 in.)

127 mm 
(5.0 in.)

476 mm (18.7 in.)
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Mounting the Backplane in a Standard 19-in. Rack
In order to mount the cFP-BP-x backplane in an EIA standard 19-in. rack, 
you need the rack-mount kit. You can order the kit, part number 
778615-01, from NI.

Figure 2-7.  Dimensions of Compact FieldPoint Rack-Mount Kit, 
Part Number 778615-01

Complete the following steps to mount the backplane in a rack:

1. Fasten the rack-mount bracket to the back of the cFP-BP-x using the 
captive screws on the bracket. Refer to Figures 2-8 and 2-9.
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Figure 2-8.  Fastening the Rack-Mount Accessory to the cFP-BP-4 Backplane

Figure 2-9.  Fastening the Rack-Mount Accessory to the cFP-BP-8 Backplane

 NATIONAL 

INSTRUMENTS

 NATIONAL 

INSTRUMENTS
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2. Bolt the rack-mount accessory to a standard 19 in. rack.

3. Connect the safety ground as explained in the Compact FieldPoint 
Safety Information section.

Caution Disconnect power before removing the backplane from the rack.

Installing a DIN Rail in the Rack-Mount Accessory
If you are using a rack-mounted cFP-BP-4, you can install a short 
(approximately 8 in.) DIN rail to the right of the backplane for mounting 
power supplies, terminal blocks, or other accessories. Refer to Figure 2-10.

Figure 2-10.  Installing a Small DIN Rail in the Rack-Mount Accessory

You can install a 16 in. DIN rail in another rack-mount accessory if you 
need more DIN rail space.

1 cFP-BP-4 Backplane
2 Screw Holes

3 Short DIN Rail for Power Supply
4 #10-32 Screws, 3/8–1/2 in.

1

2

3

4
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Mounting the cFP-BP-4 on a DIN Rail
You can mount the cFP-BP-4 backplane on a standard 35 mm DIN rail 
using the DIN rail clip, NI part number 778614-01. NI does not recommend 
mounting the cFP-BP-8 on a DIN rail. Complete the following steps to 
mount the cFP-BP-4 on a DIN rail:

1. Fasten the DIN rail clip to the cFP-BP-4 using a number 2 Phillips 
screwdriver and the 8-32 × 5/16 in. countersink screws shipped with 
the DIN rail clip(s). These screws have a nylon coating to prevent them 
from loosening. Refer to Figure 2-11.

Caution Do not use screws longer than 5/16 in. to fasten the DIN rail clip to the backplane.

Figure 2-11.  Fastening the DIN Rail Clip to the cFP-BP-4 Backplane

2. Insert one edge of the DIN rail into the deeper opening of the DIN 
rail clip, as shown in Figure 2-12.

 NATIONAL 

INSTRUMENTS
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Figure 2-12.  One Edge of DIN Rail Inserted in Clip

3. Press down firmly on the backplane to compress the spring until the 
clip locks in place on the DIN rail.

4. Connect the safety ground as explained in the Compact FieldPoint 
Safety Information section.

Caution Disconnect power before removing the backplane from the DIN rail.

Installing the cFP-21xx Controller 
on a Compact FieldPoint Backplane

Make sure that no power is connected to the controller or the backplane. 
Refer to Figure 2-13 and follow these steps:

1. Make sure that the cFP-21xx controller is right side up, with the NI 
logo at the top, and align the captive screws on the controller with the 
holes on the backplane.

2. Seat the card edge at the back of the controller in the card-edge 
connector on the backplane.

3. Press the controller firmly to seat it on the backplane.

4. Using a number 2 Phillips screwdriver with a shank of at least 64 mm 
(2.5 in.) length, tighten the captive screws to 1.1 N ⋅ m (10 lb ⋅ in.) of 
torque. The nylon coating on the screws prevents them from loosening.

1 DIN Rail Clip 2 DIN Rail Clip Spring 3 DIN Rail

2

1

3



Chapter 2 Installing Compact FieldPoint Hardware and Software

© National Instruments Corporation 2-13 cFP-21xx and cFP-BP-x User Manual

Figure 2-13.  Installing the cFP-21xx Controller on the Backplane (cFP-BP-4 Shown)

Installing I/O Modules on the Backplane
1. Align the captive screws on the I/O module with the holes on the 

backplane. Alignment keys on the I/O module prevent backward 
insertion.

2. Press firmly to seat the I/O module on the backplane.

3. Using a number 2 Phillips screwdriver with a shank of at least 64 mm 
(2.5 in.) length, tighten the captive screws to 1.1 N ⋅ m (10 lb ⋅ in.) of 
torque. The nylon coating on the screws prevents them from loosening. 

1 cFP-21xx Controller
2 Serial Number Label
3 Write-On Address Label
4 Captive Screws

5 Screw Holes
6 Card-Edge Connector
7 cFP-BP-4 Backplane

5

6

1

7

5

4

4
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Figure 2-14.  Installing an I/O Module on the Backplane (cFP-BP-4 Shown)

4. Repeat this procedure to install additional I/O modules on the 
backplane.

Connecting to Field Devices
Use cFP-CB-x connector blocks or Compact FieldPoint cabling accessories 
to connect the I/O modules to field devices. Refer to the operating 
instructions for the I/O modules, connector blocks, and cabling accessories.

1 cFP I/O Module
2 Captive Screws

3 Screw Holes
4 cFP-BP-4 Backplane

2

4

3

3

1

2
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Installing Connector Blocks on the Backplane
In order to connect I/O modules to input signals or to external loads, you 
need to install a cFP-CB-x connector block or other connectivity accessory 
for each I/O module on the backplane. Use the connector socket to the right 
of each I/O module socket.

1. Align the captive screws on the connector block with the holes on the 
backplane. The shape of the I/O connector on the connector block 
prevents backward insertion.

2. Press firmly to seat the connector block on the backplane.

3. Using a number 2 Phillips screwdriver with a shank of at least 64 mm 
(2.5 in.) length, tighten the captive screws to 1.1 N ⋅ m (10 lb ⋅ in.) of 
torque. The nylon coating on the screws prevents them from loosening. 

Figure 2-15.  Installing a cFP-CB-x Connector Block

4. Repeat this procedure to install additional connector blocks on the 
backplane.

1 cFP-CB-x Connector Block
2 cFP I/O Module

3 Screw Holes
4 Connector Slot

3

4

3

1

2
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Connecting the cFP-21xx to a Network
Connect the cFP-21xx controller to an Ethernet network using the RJ-45 
Ethernet port on the module. Use a standard Category 5 Ethernet cable to 
connect the cFP-21xx to an Ethernet hub, or use an Ethernet crossover cable 
to connect the module directly to a computer.

Caution To prevent data loss and to maintain the integrity of your Ethernet installation, 
do not use a cable longer than 100 m. If you are using a 100 Mbps Ethernet, 
NI recommends using a Category 5 shielded twisted-pair Ethernet cable.

The host PC communicates with the cFP-21xx over a standard Ethernet 
connection. If the host PC is already configured on a network, you must 
configure the cFP-21xx on the same network. If neither is connected to a 
network, you can connect the two directly using a CAT-5 crossover cable. 
If you need to build your own cable, refer to the Cabling section of 
Appendix B, Specifications, for more information about Ethernet cable 
wiring connections.

In order to configure the cFP-21xx, it must reside on the same subnet as the 
host PC. If you want to use the cFP-21xx on a subnet other than the one the 
host PC is on, first connect and configure it on the same subnet as the host 
PC, then reassign a static IP address for the subnet where you want it to be 
and physically move it to the other subnet. Contact your network 
administrator if you need assistance configuring the host PC and cFP-21xx 
on the same subnet.

Wiring Power to the Compact FieldPoint System
Each cFP-21xx on your network requires an 11–30 VDC power supply. 
NI recommends the PS-5 power supply for most Compact FieldPoint 
applications.

The cFP-21xx filters and regulates the supplied power and provides power 
for all the I/O modules on the backplane. Refer to the documentation for the 
individual I/O modules to determine whether they require any additional 
power in your applications.

Figure 2-16 shows the 6-pin screw-terminal power connector on the 
cFP-21xx.
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Figure 2-16.  cFP-21xx Power Connector

1. Connect the positive lead of the primary power supply to one of the 
V1 terminals and the negative lead to one of the C terminals.

2. If you are using a backup power supply, connect the positive lead to V2 
and the negative lead to one of the C terminals. The cFP-21xx generally 
uses the power supply with the higher voltage level. V2 is isolated from 
the other V terminals.

3. If module-to-module isolation is important in your application, use a 
separate power supply for each module that needs external power. If 
your application does not require module-to-module isolation, you can 
cascade power, using the same power supply for all modules that 
require external power.

Caution Cascading power defeats isolation between the cascaded modules.

4. Refer to the operating instructions for the power requirements of each 
I/O module. If a module requires external power, connect a power 
supply to the appropriate input terminals on the connector block. If you 
want to power field I/O devices from a connector block, supply power 
to the connector block, and then connect the connector block output 
terminals to the field device.

Powering Up the cFP-21xx
Check the DIP switches on the controller, making sure that the RESET IP 
switch is not enabled. Refer to Chapter 3, Feature Descriptions, for a 
description of the DIP switches. Plug in each power supply to the Compact 
FieldPoint system. The cFP-21xx runs a power-on self test (POST) that 
takes several seconds. You should see the POWER and STATUS LEDs 
come on. After about five seconds, the STATUS LED begins flashing. The 
cFP-21xx is ready to be configured, and you can install the FieldPoint 
software.

C

V1

V2
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If you have already assigned an IP address to the cFP-21xx, the STATUS 
LED turns off, the I/O module READY LEDs come on, and the cFP-21xx 
is ready for use. The total boot time for a configured system is 
15–20 seconds.

If the STATUS LED does not light up as described here, refer to the 
STATUS LED Error Indications section of Appendix A, Troubleshooting.

Installing Software on the Host PC
The cFP-21xx has the embedded LabVIEW Real-Time Engine and 
FieldPoint software pre-installed, but you must install the necessary 
software on the host PC. Follow these steps to install the FieldPoint 
software on the host PC.

1. Install the software packages you plan to use, such as LabVIEW, 
LabVIEW Real-Time, Lookout, Measurement Studio, VI Logger, or 
LabWindows/CVI, before you install the FieldPoint software. The 
FieldPoint software installation installs the LabVIEW VIs and 
examples and the LabWindows/CVI instrument driver only if it finds 
the corresponding development software installed.

2. Close all other applications.

3. Insert the FieldPoint software CD into the CD-ROM drive on your 
computer.

4. Follow the onscreen instructions to complete the installation.

Note If the setup does not launch automatically, select Start»Run from Windows, 
enter either d:\setup or d:\autorun, where d is the letter of your CD-ROM drive, 
and select OK.

Configuring the Compact FieldPoint System in MAX
Refer to the Measurement & Automation Explorer Help for FieldPoint for 
information about configuring the Compact FieldPoint system in MAX.
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3
Feature Descriptions

Guarding against Network Failures (Network Watchdog)
The network watchdog feature of the cFP-21xx enables you to guard your 
system against failures in the network connection, cables, or host computer. 
If the network watchdog is enabled and the cFP-21xx loses communication 
with all hosts or clients over the network, the cFP-21xx sets output channels 
to predefined values (the watchdog state). The network watchdog is 
disabled by default.

Note National Instruments recommends leaving the network watchdog disabled when 
you are running embedded applications on the cFP-21xx. Refer to the section of this 
chapter for information about the hardware watchdog for embedded applications.

Network watchdog output values can be different than power-up output 
values. For example, you may want to turn an output value on when you 
power up, but turn it off if network communication is lost.

Refer to the Measurement & Automation Explorer Help for FieldPoint for 
information about enabling and configuring the network watchdog.

Guarding against Other System Failures 
(Hardware Watchdog)

In addition to the network watchdog, the cFP-21xx controller supports a 
hardware watchdog that you can set up in LabVIEW Real-Time. The 
hardware watchdog enables the controller to respond in predetermined 
ways to failures in the system. The VIs to control the hardware watchdog 
are on the LabVIEW Real-Time palette.
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Storing a Custom Power-Up Configuration

Setting a Power-Up State with the Snapshot Feature
The Snapshot feature stores the current state of the Compact FieldPoint 
hardware for use as the power-up state of the system.

Caution Using the Snapshot feature overwrites any power-up values you have specified 
for individual channels.

Refer to the Measurement & Automation Explorer Help for FieldPoint for 
information about using the Snapshot feature.

Configurable Power-Up States
With the configurable power-up state feature, you can define the power-up 
configuration on a module-by-module basis. You do not need to set any of 
the channels to the desired power-up state as you would with the Snapshot 
feature. However, you can use configurable power-up states to adjust 
previously stored Snapshot information. In this way, you can make 
incremental changes to the power-up values of individual channels.

Refer to the Measurement & Automation Explorer Help for FieldPoint for 
information about using configurable power-up states.

Inserting, Removing, and Replacing I/O Modules
You can remove and insert I/O modules while the system is operating. You 
do not need to power down the Compact FieldPoint system. I/O modules 
already working in the system remain fully operational and accessible on 
the network. Commands sent to a missing module return an error response, 
but the cFP-21xx stores the commands and applies the effects of the 
commands if a suitable replacement module is inserted.

Caution Do not add or remove connector blocks while power is applied to the system.

When you remove an I/O module and insert a new one, the cFP-21xx first 
verifies that the replacement I/O module is compatible with the one that 
was removed. If the I/O module is the same as, or is compatible with, the 
one removed, the cFP-21xx configures the replacement I/O module with its 
predecessor’s configuration and output value settings.
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Table 3-1 shows how modules are configured after hot swapping.

LED Indicators
The cFP-21xx has several LEDs to indicate status information.

POWER LED
The green POWER LED is lit while the cFP-21xx is powered on. 
This LED indicates that the power supply connected to the cFP-21xx is 
acceptable, and that the cFP-21xx is supplying power to the I/O modules.

STATUS LED
The red STATUS LED is off in normal operation mode. The cFP-21xx 
indicates specific error conditions by flashing STATUS a specific number 
of times. Refer to the STATUS LED Error Indications section of 
Appendix A, Troubleshooting, for more information about STATUS 
LED error indications.

LINK ACT LED
The yellow LINK ACT LED blinks when the cFP-21xx receives data from 
or transmits data to the Ethernet. Unrelated network activity causes this 
LED to blink occasionally even when the cFP-21xx is inactive.

Table 3-1.  Module Configuration Results After Hot Swapping

Replacement
Module

Factory Configuration 
Checked?1

Replacement Module 
Configuration after Hot Swapping

Compatible with the removed 
module

Yes or No Same as the removed module

Incompatible with the removed 
module but compatible with the 
stored configuration

No Same as the stored configuration

Yes Factory default configuration

Incompatible with the removed 
module and incompatible with 
the stored configuration

Yes or No Factory default configuration

1 The factory configuration checkbox is on the Bank Configuration tab in MAX.
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100 Mbps LED
The green 100 Mbps LED is lit when the cFP-21xx is communicating 
at 100 megabits per second. If the 100 Mbps LED is not lit, the cFP-21xx 
is communicating at 10 megabits per second.

User-Configurable LEDs A–D
LEDs B, C, and D can be sent values of 0, 1, or 2. LED A should be sent 
only 0 or 1. LED A handles a 2 as a 1. The values sent to these LEDs 
manifest as 0 = off, 1 = green, and 2 = red.

Power-On Self Test (POST)
The cFP-21xx runs a power-on self test (POST) at power-up to verify its 
operational status. The test takes several seconds, does not affect the 
operation of the network, and does not affect any of the field wiring on 
connector blocks installed on the backplane.

If the power-on self test fails, the cFP-21xx does not participate in network 
communication, eliminating potential conflicts with other controllers on 
the network.

When you power up the cFP-21xx and it has already been configured for 
use, the POWER and STATUS LEDs turn on for about five seconds, then 
the STATUS LED turns off. When the I/O module READY LEDs turn on, 
the controller is ready for use.

The cFP-21xx indicates POST failure through the STATUS LED. If the 
LEDs do not follow the sequence described here, refer to the STATUS LED 
Error Indications section of Appendix A, Troubleshooting, for information 
about possible reasons.
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DIP Switches
The following figure shows the DIP switches on the front of the cFP-21xx.

 

Figure 3-1.  cFP-21xx DIP Switches

DIP switches 3 and 4 are user configurable on the cFP-21xx. 
Switches 1 and 2 are user configurable on the cFP-2100 and cFP-2110 
but are disabled on the cFP-2120. FieldPoint LabVIEW VIs, CVI, OPC, 
Lookout, and other applications can read these switches, but the switches 
have no default functionality.

DIP switches 5, 6, 7, and 8 are the CONSOLE OUT, DISABLE VI, 
SAFE MODE, and RESET IP switches. The cFP-21xx reads these switches 
only when powering up or rebooting. You must reboot the module with one 
of these switches ON for its setting to take effect.
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CONSOLE OUT Switch
With a serial-port terminal program, you can use the Console Out switch to 
read the IP address and BIOS version of the controller. Connect the serial 
port on the controller to a computer. Push the switch to the ON position.

Make sure that the serial-port terminal program is configured to the 
following settings:

• 9,600 bits per second

• Eight data bits

• No parity

• One stop bit

The serial-port terminal program displays the IP address and BIOS version. 
Keep this switch in the OFF position during normal operation.

DISABLE VI Switch
The position of the DISABLE VI switch determines whether any VIs run 
at startup. You can instruct the cFP-21xx controller to run a VI when it 
starts up, but if this VI consumes all of the cFP-21xx CPU resources for any 
reason, it can make the module inaccessible on the network. If you reboot 
the cFP-21xx with the DISABLE VI switch in the ON position, the module 
does not run any VIs at startup.

SAFE MODE Switch
The position of the SAFE MODE switch determines whether the cFP-21xx 
controller starts up in safe mode. Safe mode disables all LabVIEW 
functions and communication with I/O modules. If the software or 
configuration information on the controller becomes corrupt or cannot be 
read correctly, the system may hang after being rebooted or become 
inaccessible over the network. Safe mode enables you to reconfigure 
network settings and reinstall software on the controller.

Reboot the controller with the SAFE MODE switch in the ON position and 
reinstall software using MAX. Then reboot the controller with the SAFE 
MODE switch in the OFF position.

If reinstalling software does not work and you still cannot communicate 
with the controller over the network, use the Format Disk function in MAX 
to reformat the controller. Then reconfigure the TCP/IP settings, download 
new software to the controller using MAX, and reboot the cFP-21xx with 
the SAFE MODE switch in the OFF position.
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RESET IP Switch
Push the RESET IP switch to the ON position and reboot the controller to 
reset the IP address of the controller to 0.0.0.0. If the controller is on your 
local subnet and the RESET IP switch is in the ON position, the controller 
appears in MAX with IP address 0.0.0.0. You can configure a new IP 
address for the controller in MAX. Refer to the Remote Systems Help in 
MAX for more information about resetting the IP address.

Serial Ports
Refer to the cFP-21xx Compact FieldPoint Controller Overview section of 
Chapter 1, Overview of Compact FieldPoint, to find the serial ports on the 
controller. If you are not running an embedded application, you must target 
the cFP-21xx in order to access the serial ports. Refer to the LabVIEW Help 
for more information about targeting the cFP-21xx.

COM 1
COM 1 is an RS-232 DTE serial port with a standard DB-9 connector. The 
Serial Port VIs access COM 1 as port 0. Figure 3-2 shows the locations of 
the DB-9 connector pins and Table 3-2 lists the signals on the pins.

Figure 3-2.  DB-9 Connector Pin Locations

Table 3-2.  DB-9 Pin Descriptions

DB-9 Pin RS-232 Signal

1 DCD

2 RXD

3 TXD

4 DTR

5 GND

PIN 1

PIN 9PIN 5

PIN 6
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COM 2 (cFP-2110 and cFP-2120 Only)
COM 2 is an RS-232 DTE serial port with a 10-position modular jack. The 
Serial Port VIs access COM 2 as port 1. Refer to Figure 3-3 and Table 3-3 
for pin locations and signal descriptions.

COM 3 (cFP-2120 Only)
COM 3 is an RS-232 DTE serial port with a 10-position modular jack. The 
Serial Port VIs access COM 3 as port 2. Refer to Figure 3-3 and Table 3-3 
for pin locations and signal descriptions.

COM 4 (cFP-2120 Only)
COM 4 is an RS-485 serial port with a 10-position modular jack. The Serial 
Port VIs access COM 4 as port 3. COM 4 has 100 Vrms of operational 
isolation. Use an external RS-485 isolator if your application requires more 
isolation. Refer to Figure 3-3 and Table 3-3 for pin locations and signal 
descriptions.

Figure 3-3.  10-Position Modular Jack Pin Locations

6 DSR

7 RTS

8 CTS

9 RI

Table 3-2.  DB-9 Pin Descriptions (Continued)

DB-9 Pin RS-232 Signal

Pin 10Pin 1
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Figure 3-4 shows how to wire several FP-1001 banks in an RS-485 network 
controlled by the cFP-2120. Only two FP-1001 banks are shown, but the 
cFP-2120 can control up to 24 FP-1001 banks. Install 120 Ω termination 
resistors at each end of the network as shown in Figure 3-4.

Figure 3-4.  Wiring for an RS-485 Network Controlled by the cFP-2120

Table 3-3.  10-Position Modular Jack Pin Descriptions 

10-Position 
Modular Jack Pin RS-232 Signal RS-485 Signal

10 DCD GND

9 RXD CTS+ (HSI+)

8 TXD RTS+ (HSO+)

7 DTR RXD+

6 GND RXD–

5 DSR CTS– (HSI–)

4 RTS RTS– (HSO–)

3 CTS TXD+

2 RI TXD–

1 No Connect No Connect

RXD– RXD+ TXD– TXD+ RX– RX+ TX– TX+ RX– RX+ TX– TX+

cFP-2120 COM 4 FP-1001 FP-1001

120 Ω 120 Ω120 Ω120 Ω
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COM 4 is designed to operate in four-wire mode as shown in Figure 3-4. 
You can use COM 4 in two-wire mode, but you must design your 
application so that it filters out the writes that echo back over the read 
channels. NI does not recommend this method.

NI offers a DIN rail–mountable screw terminal adapter that you can use to 
connect termination resistors to COM 4. The adapter is part number 
778674-01.

Cable adapters for the 10-position modular jacks are available from NI. 
Part numbers 182845-01, -02, and -03 are 1, 2, and 3 m cable adapters for 
connecting the 10-position modular jack to a 9-position D-Sub plug.

External Switch Inputs and LED Outputs (cFP 2120 Only)
The cFP-2120 has two switch inputs and two LED outputs that you can use 
to connect a simple operator interface to the controller. Refer to Figure 1-1 
for the location of the input and output terminals. The inputs and outputs 
appear in software as Input 1, Input 2, LED A, and LED B. Logic high for 
the DIO ports is +5 V. Logic low is 0 V. The DIO ports are not isolated and 
are not intended for field connections. Use them only for simple VI controls 
and indicators.

Outputs 1 and 2 are tied to LEDs A and B, respectively, on the cFP-2120 
front panel. When LED A has a value of 1 or 2, Output 1 is ON and sources 
+5 V. When LED A has a value of 0, Output 1 is OFF and does not source 
voltage. When LED B has a value of 1, Output 2 is ON and sources +5 V. 
When LED B has a value of 0 or 2, Output 2 is OFF and does not source 
voltage. You can use the outputs to provide status or alarm indicators to 
operators. For example, if the Compact FieldPoint bank is mounted in a 
sealed enclosure, you can connect the outputs to external LEDs so that 
operators can see status information without opening the enclosure.

You can use the two switch inputs to control the cFP system from 
LabVIEW. For example, one switch input could be a START/STOP switch, 
and the other could determine which of two VIs should run at startup. NI 
recommends connecting a single-pole single-throw (SPST) switch between 
the input terminal and one of the C terminals. The switch inputs have a 
value of 1 when the switch is closed and 0 when the switch is open.
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Figure 3-5.  Wiring the cFP-2120 External Input and Output Terminals

Power Source (Isolated Power Connector)
The cFP-21xx power connector is a 6-pin screw-terminal connector that 
accommodates both primary and backup power supplies. The cFP-21xx 
uses the power supply with the higher voltage level, indicating which 
supply it is using on the channel called Power Source in software. A value 
of 0 indicates the primary supply, and a value of 1 indicates the backup 
supply. If the output voltages of the two power supplies are within 
0.1–0.6 V of each other, the cFP-21xx can use either supply.

Removable Compact Flash (cFP-2120 Only)
You can use compact flash for removable data storage with the cFP-2120. 
The controller takes Type I and Type II compact flash up to 512 MB. With 
the power off, open the compact flash cover and plug a compact flash into 
the slot, then power up the controller. You can access the removable 
compact flash by using LabVIEW file I/O VIs running embedded on the 
controller. To read from or write to the removable compact flash, point the 
VI to the D drive on the controller.

Caution You must power down the controller before installing or removing a compact 
flash. Removing the compact flash without powering down the controller can cause data 
corruption. In order to get data from the compact flash while the controller is operating, 
use an FTP client or a LabVIEW remote front panel and download the data from the D 
drive on the controller.
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File Transfer Capability
When running on a cFP-21xx, the Real-Time Engine has a File Transfer 
Protocol (FTP) server. The FTP server gives you the ability to use any 
standard FTP utility for transferring files to and from the hard drive of the 
cFP-21xx. You must provide the correct password when opening a 
connection to the cFP-21xx if the configuration is locked in MAX.

For programmatic file transfer control in LabVIEW or LabVIEW 
Real-Time, use the Internet Developers Toolkit, included in the LabVIEW 
Enterprise Connectivity Toolset. Refer to ni.com for more information 
about the LabVIEW Enterprise Connectivity Toolset.

Note Contact NI to determine whether the version of the toolkit you are using can be 
downloaded onto the cFP-21xx.

Remote Front Panels
You may need to monitor and control an embedded VI remotely. The 
cFP-21xx supports multiple remote front panels for embedded VIs. Users 
can view the remote front panel using either LabVIEW or a Web browser.

Users accessing the remote front panels with a Web browser need to have 
either Internet Explorer 5.5 Service Pack 2 or later, or Netscape 4.7 or later.

If you plan to use remote front panels to control the VI, keep the front panel 
simple and do not use property nodes. Complex front panels can cause 
slight control latency when users operate them remotely. Users cannot 
programmatically change the value of a control remotely.

The cFP-2100 can support up to five remote connections, and the cFP-2110 
and cFP-2120 can support 20.
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4
LabVIEW Real-Time 
Programming

This chapter contains specific information about targeting 
LabVIEW Real-Time to the cFP-21xx module, network options for 
restricting access to the module, embedding LabVIEW Real-Time 
applications on the module, and launching embedded applications 
when the module starts up. For general LabVIEW Real-Time programming 
information, refer to the LabVIEW Help.

Targeting LabVIEW Real-Time to a Platform
You can target LabVIEW Real-Time to the cFP-21xx or to the host PC. 
When you select a target platform other than the host PC, the 
Real-Time Development System downloads any LabVIEW Real-Time 
application you subsequently run to the selected target platform. Refer 
to the LabVIEW Help for more information about the 
Real-Time Development System.

Targeting LabVIEW Real-Time to the cFP-21xx
When you target LabVIEW  Real-Time to the cFP-21xx, you can run 
LabVIEW Real-Time applications on the controller. However, when 
targeted to the cFP-21xx, LabVIEW Real-Time lacks some features found 
in LabVIEW for Windows because the controller does not have all the 
software of a PC. The following LabVIEW functions are not supported in 
LabVIEW Real-Time when targeted to the cFP-21xx:

• ActiveX

• Front panel datalogging

• Dialog boxes

• Printing

• Programmatic menus

• Front panel Web publishing

• NI driver software for non-FieldPoint hardware
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LabVIEW Real-Time applications that have any of the unsupported 
functionality previously listed may or may not work as expected on the 
cFP-21xx.

Complete the following steps on the host PC to target LabVIEW Real-Time 
to the cFP-21xx:

1. Start LabVIEW.

2. Open a new VI.

3. Select Operate»Switch Execution Target to open the Select Target 
Platform dialog box, shown in the following figure.

4. Select the target platform from the pull-down menu.

5. Select RT Target on Network to target the cFP-21xx.

Note The module need not reside on the same subnet as the host PC.

6. Enter the IP address and password you specified for the cFP-21xx in 
MAX. If no password is specified for the cFP-21xx, leave the password 
field blank. 

Refer to the RT Target: Access section for more information.

7. Click OK.
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Targeting LabVIEW Real-Time to the Host PC
When you target LabVIEW Real-Time to the host PC, you can use 
LabVIEW Real-Time as you would use LabVIEW for Windows.

Complete the following steps to target LabVIEW Real-Time to the host PC:

1. Complete steps 1 through 4 of the Targeting LabVIEW Real-Time to 
the cFP-21xx section.

2. Select Host PC (LabVIEW for Windows).

3. Click OK.

Note Applications running on the host PC communicate with FieldPoint I/O channels. 
However, serial communication is routed to the host PC serial port rather than to the 
cFP-21xx serial port. VIs that use the serial port communicate using the host PC serial port. 
Also, when an application runs on the host, deadbands apply to FieldPoint I/O channels.

RT Target Options
When you target LabVIEW Real-Time to a networked cFP-21xx, select 
Tools»Options to access LabVIEW options. The options in the Options 
menu apply only to the Real-Time Development System running on the 
host PC.

You also can set options for the Real-Time Engine on the cFP-21xx when 
you target LabVIEW Real-Time to the controller. With LabVIEW 
Real-Time targeted to the cFP-21xx, select Tools»RT Target Options to 
access Real-Time Engine options. Real-Time Engine options apply to 
LabVIEW Real-Time applications running on the cFP-21xx. The 
VI Server and Web Server option dialog boxes are identical to the normal 
LabVIEW option dialog boxes. However, the settings are applied to the 
cFP-21xx. Refer to the LabVIEW Help for more information about the 
VI Server and Web Server options.

You also can use the following two additional groups of options for 
LabVIEW Real-Time applications on networked cFP-21xx modules: 
RT Target: Access and RT Target: Miscellaneous.
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RT Target: Access
Use RT Target: Access options to limit which host PCs can target the 
Real-Time Engine on the cFP-21xx.

Complete the following steps to open the RT Target: Access dialog box:

1. Target LabVIEW Real-Time to the cFP-21xx. Refer to the Targeting 
LabVIEW Real-Time to the cFP-21xx section for more information.

2. Select Tools»RT Target: x.x.x.x:Options, where x.x.x.x is the IP 
address of the cFP-21xx.

3. Select RT Target: Access from the pull-down menu to see the 
following dialog box.

If the IP address of the host PC matches an entry that allows access, you can 
target the cFP-21xx without providing a password, even if the module 
configuration is locked. If the host IP address does not match any entry or 
matches an entry that denies access, you must provide the correct password 
to target the cFP-21xx.

When you try to target the Real-Time Engine on a cFP-21xx from a host PC 
through the Real-Time Development System, the Real-Time Engine 
compares the host PC’s IP address to the entries in the RT Target Access 
List to determine if the host PC is permitted access. You define the 
RT Target Access List entries to indicate whether or not a host PC is 
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permitted or denied access. If an entry in the list matches the host PC 
address, the Real-Time Engine either allows or denies access based on what 
you define for the entry. If a subsequent entry also matches the host PC 
address, that permission is used in place of the previous permission. For 
example, in the RT Target: Access dialog box shown, a.test.site.com 
and b.test.site.com are permitted access even though the list indicates 
by the * wildcard that all addresses ending in .test.site.com are denied 
access. A checkmark next to a list entry denotes that access is permitted, 
while an X denotes that access is denied. If no entry matches the host PC 
address, access is denied unless you supply a password.

Table 4-1 shows examples of RT Target Access List entries and provides 
information about the * wildcard and permitting matching access entries.

To specify an Internet host address, enter its domain name or IP address. 
Use the * wildcard when specifying Internet host addresses. For example, 
you can specify all hosts within the domain site.com with the entry 
*.site.com. You can specify all hosts in the subnet whose first two 
numbers are 130.164 with the entry 130.164.*. The entry * matches all 
addresses.

In the RT Target: Access dialog box previously shown, all hosts in 
the site.com domain can target the Real-Time Engine, with the exception 
of all hosts in the test.site.com domain. Additionally, the hosts 
a.test.site.com, b.test.site.com, and 130.164.123.123 also 
can target the Real-Time Engine. The host public.site.com does not 
have access, even though it is in the site.com domain.

Table 4-1.  Example RT Target Access List Entries

Access String Matches

* All hosts

test.site.com The host whose domain name is 
test.site.com

*.site.com All hosts whose domain names end 
with .site.com

130.164.123.123 The host with the IP address 
130.164.123.123

130.164.123.* All hosts whose IP addresses start 
with 130.164.123
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The default RT Target: Access settings permit any host machine to target 
the Real-Time Engine on the cFP-21xx without a password.

Note If the cFP-21xx does not have access to a Domain Name Server (DNS), do not use 
domain name entries in the RT Target Access List. Requests to resolve domain names to 
IP addresses fail and slow down the system. Place frequently matched entries toward the 
bottom of the RT Target Access List to improve system performance.

RT Target: Miscellaneous
Use RT Target: Miscellaneous options to launch LabVIEW Real-Time 
applications at system startup and to specify the Downloaded VI Path.

Complete the following steps to open the RT Target: Miscellaneous 
dialog box:

1. Target LabVIEW Real-Time to the cFP-21xx. Refer to the Targeting 
LabVIEW Real-Time to the cFP-21xx section for more information 
about targeting LabVIEW Real-Time to the cFP-21xx.

2. Select Tools»Network Options.

3. Select RT Target: Miscellaneous from the pull-down menu to see the 
following dialog box.
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Use the Application Path and Launch Application at Boot-up settings to 
automatically launch a built LabVIEW Real-Time application when you 
start up the cFP-21xx. The LabVIEW Real-Time Engine launches the built 
application specified by Application Path when you start up the cFP-21xx. 
The specified path also determines the path and application name that 
appear when you target LabVIEW Real-Time to the cFP-21xx and create an 
embedded LabVIEW Real-Time application. Refer to the Embedding 
Applications on the cFP-21xx and Launching Embedded Applications at 
Startup sections for more information about embedding and launching 
LabVIEW Real-Time applications on the cFP-21xx.

Select Launch Application at Boot-up to launch the application specified 
in Application Path when you start up the cFP-21xx. You must first create 
the application using the Application Builder before you select this option. 
Refer to the LabVIEW Application Builder Release Notes and to the 
LabVIEW Help for more information about the Application Builder. Refer 
to the Embedding Applications on the cFP-21xx section for more 
information about creating LabVIEW Real-Time applications.

By changing the Application Path, you can create multiple 
LabVIEW Real-Time applications on the cFP-21xx. However, if you 
select Launch Application at Boot-up, only the application you specify 
in the Application Path launches at startup.

Use Downloaded VI Path to specify the default path for the Real-Time 
Engine VIs downloaded by the Real-Time Development System. VIs are 
stored on the host PC hard drive and are opened in the host Real-Time 
Development System. Therefore, the Real-Time Engine does not know the 
actual path of the downloaded VIs. The Real-Time Engine uses the path 
specified in Downloaded VI Path for operations that require the VI path. 
For example, the file constant Current VI’s Path normally returns the path 
of the VI in which the constant is used. This constant may be used in a VI 
that reads or writes data to a file on the disk. When you run this VI in the 
LabVIEW Real-Time Engine on the cFP-21xx, Current VI’s Path returns 
the path specified in the Downloaded VI Path option, appended with the 
name of the VI.

Embedding Applications on the cFP-21xx
LabVIEW Real-Time applications built on the host PC with the 
Application Builder can be embedded on the cFP-21xx. This section 
explains how to embed LabVIEW Real-Time applications on the cFP-21xx 
by using the Application Builder while LabVIEW Real-Time is targeted to 
the controller.
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Refer to the LabVIEW Help for more information about building LabVIEW 
Real-Time applications on the host PC. Refer to the LabVIEW Application 
Builder Release Notes and to the LabVIEW Help for more information 
about using the Application Builder on the host PC.

Command Line Arguments
Use command line arguments for applications built on the host PC to 
disable the Select Target Platform dialog box and to explicitly specify a 
target for the application. You can use these command line arguments in 
a shortcut from the Windows Startup folder to automatically launch 
Real-Time Engine applications and/or host PC applications when you start 
up the host PC.

For example, create a shortcut with the following shortcut target:

c:\mybuiltapp.exe -target 127.127.44.108 -quithost

To disable the Select Target Platform dialog box, specify a target, such as 
the IP address of the cFP-21xx, in the command line argument of your 
application using -target. For example,

c:\mybuiltapp_rtengine.exe -target 127.127.44.108

or

c:\mybuiltapp_host.exe -target host

To disconnect the host PC from the Real-Time Engine after all applications 
are downloaded, use -quithost. For example,

c:\mybuiltapp_rtengine.exe -target 127.127.44.108 

-quithost

Using Application Builder
When you target LabVIEW Real-Time to the cFP-21xx, use the 
Application Builder to embed LabVIEW Real-Time applications on 
the cFP-21xx.

Complete the following steps to embed LabVIEW Real-Time applications 
on the cFP-21xx using the Application Builder:

1. Target LabVIEW Real-Time to the cFP-21xx. Refer to the Targeting 
LabVIEW Real-Time to the cFP-21xx section for more information.

2. Open a new VI.
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3. Select Tools»Build Application or Shared Library (DLL) to open 
the Build Application or Shared Library (DLL) dialog box, shown in 
the following figure.

4. Select Application (EXE) from the Build target pull-down menu.

5. Click the Source Files tab.

6. Click Add Top-Level VI.

7. Navigate to the location of the VI to be added.

8. Select the VI to be added.

9. Click OK.

10. Click Build.

Target Tab
On the Target tab, the Application Builder determines the Target file 
name, Destination directory, and Support file directory from the 
Application Path setting in RT Target Options. You cannot change the 
Application name, Destination directory, and Support file directory 
settings in the Application Builder when you target LabVIEW Real-Time 
to the cFP-21xx. Refer to the RT Target Options section for more 
information about accessing and using RT Target Options.
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If you select Small target with external file for subVIs in the Build 
Options pane, you cannot change the LLB for other files path because this 
path is determined from the Application Path setting in Network 
Options. Refer to the LabVIEW Help for more information about the Small 
target with external file for subVIs option. Refer to the RT Target 
Options section for more information about accessing and using RT 
Target Options.

Source Files and VI Settings Tabs
Use the Source Files and VI Settings tabs the same way you do to build a 
LabVIEW Real-Time application when LabVIEW Real-Time is targeted to 
the host PC. Refer to the LabVIEW Help for more information about the 
Source Files and VI Settings tabs.

Application Settings and Installer Settings Tabs
The Application Settings and Installer Settings tabs are disabled when 
you target LabVIEW Real-Time to the cFP-21xx because these settings do 
not apply to applications embedded on the controller.

Launching Embedded Applications at Startup
The Real-Time Engine can launch your embedded application each time 
you start up the cFP-21xx. Complete the following steps to launch the 
embedded application each time the cFP-21xx starts up:

1. Target LabVIEW Real-Time to the cFP-21xx. Refer to the Targeting 
LabVIEW Real-Time to the cFP-21xx section for more information 
about targeting LabVIEW Real-Time to the cFP-21xx.

2. Select Tools»RT Target Options.

3. Select RT Target: Miscellaneous from the pull-down menu.

4. Select Launch Application at Boot-up.

5. Click OK.
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5
Accessing cFP-21xx Channels 
from PC Applications

This chapter describes how to access channels on the cFP-21xx from other 
software running on a PC after you configure the system in MAX. For 
information about configuring the Compact FieldPoint system in MAX, 
refer to the Measurement & Automation Explorer Help for FieldPoint.

Using the cFP-21xx from PC Applications
The primary intended use for the cFP-21xx is to run LabVIEW Real-Time, 
but you can use the controller with other software on a PC, even while the 
controller is running LabVIEW Real-Time. The following sections explain 
how to access the channels on the cFP-21xx from software running on a PC.

LabVIEW VIs and the cFP-21xx
When you install the FieldPoint software, a library of FieldPoint VIs is 
created if LabVIEW has already been installed on your computer. The 
FieldPoint VIs directly access I/O items configured in MAX. For help 
using these VIs, refer to the FieldPoint LabVIEW Interface Help accessible 
from the LabVIEW help menu, or to the FieldPoint examples in 
LabVIEW\examples\FieldPoint. You can use this same set of VIs to 
access the cFP-21xx by Ethernet from the host PC or to run an embedded 
application. For more information about programming embedded 
applications for the cFP-21xx, refer to Chapter 4, LabVIEW Real-Time 
Programming.

LabWindows/CVI Functions and the cFP-21xx
When you install the FieldPoint software, a LabWindows/CVI instrument 
driver for FieldPoint is installed if LabWindows/CVI has already been 
installed on your computer. This instrument driver includes function panels 
to call C functions that directly access I/O items you configured in MAX. 
In addition, a set of sample projects is placed in your LabWindows/
CVI Samples directory. Using these examples is the best way to get 
familiar with these functions. The FieldPoint LabWindows/CVI Interface 
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Help describes each function in the instrument driver with a description of 
the C syntax, a description of each parameter, and a list of possible error 
codes.

Note FieldPoint CVI Interface Compatibility Modes—The FieldPoint software ships 
with object (.obj) files to support the different compiler compatibility modes that 
LabWindows/CVI supports (Microsoft Visual C/C++, and Borland). When the FieldPoint 
software is installed, the .obj file corresponding to the configured compatibility mode is 
installed.

FieldPoint OPC Server and the cFP-21xx
The FieldPoint OPC server conforms to the OPC Data Access 2.0 standard. 
OPC (OLE for Process Control) is an industry-standard device interface 
specification that provides interoperability between field devices such as 
FieldPoint and application software packages. The FieldPoint OPC server 
imports I/O items that you configured in MAX and makes them available 
as OPC items to any OPC client. Therefore, if two computers are 
networked together, it is possible for an OPC client on one computer to 
access FieldPoint hardware connected to the OPC server on another 
computer. 

OPC clients differ in the features they offer and in their presentation of the 
OPC interface for the FieldPoint OPC server. Refer to the documentation 
on using the OPC client features of your application for detailed 
instructions on how to access an OPC server. However, the basic steps 
involved are similar for most OPC client applications. 

Follow these steps to use the FieldPoint OPC server:

1. Launch your OPC client.

2. Open the FieldPoint OPC server, 
National Instruments.OPCFieldPoint, from the OPC client. 

This server was registered with Windows when you installed the 
FieldPoint software. OPC clients should be able to show you a list 
of available registered servers, but you may have to type this name 
in yourself. The OPC client may automatically connect to the server 
when you select it, but if you are given the option to connect to the 
FieldPoint OPC server, you should do so.

3. Create a group. 

Groups are a collection of I/O items. Some OPC clients might not give 
you the option of creating groups, or they might be created for you.
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4. The OPC server loads the last saved .iak file on startup. Select the I/O 
items you configured in MAX that you want to read or write as a part 
of this group. 

Many OPC clients can use the Browse Address Space feature of the 
FieldPoint OPC server to show you a list of all the I/O items you 
configured in MAX. However, if the OPC client you are using does not 
support this feature, you may need to type the item IDs of the I/O items 
directly. The naming convention of the FieldPoint item IDs is Comm 
resource name\Device Name\I/O item name, where the values 
are the names given in MAX. For example, an item ID associated with 
one of the I/O items might be the following:

FP Res\cFP-TC-120 @1\Channel 0

In most cases, the preceding steps are all that is required to configure an 
OPC client to read from I/O items of the FieldPoint OPC server. In some 
cases, the OPC client might require more information about the FieldPoint 
OPC server. The following list contains additional information about the 
FieldPoint OPC server, which you may find helpful.

• The FieldPoint OPC server does not require an access path. Some OPC 
clients expect the access path to be included in the item ID name or 
might request the access path when you select I/O items. You should 
be able to leave the access path blank (empty string).

• The FieldPoint OPC interface is an out-of-process server.

• The FieldPoint OPC server supports both synchronous and 
asynchronous reads and writes.

• The FieldPoint OPC server uses the GetErrorString method to return 
error and diagnostic messages from the FieldPoint server and 
hardware. OPC clients that do not support this method might give you 
error messages like “Bad, non-specific” along with an error code. 
Some OPC clients that do not support this GetErrorString method still 
provide a way for you to manually look up the FieldPoint message 
corresponding to the error code using the method.

Data Communications
The cFP-21xx network module provides several methods for 
communicating and sharing data with other FieldPoint systems, computers, 
and devices. The most common methods are to use DataSocket, serial VIs, 
TCP VIs, UDP VIs, or Data Publishing VIs, as described in the following 
sections.
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DataSocket
DataSocket, a programming technology based on TCP/IP, simplifies live 
data exchange between different applications on one computer or between 
computers connected on a network. DataSocket was designed as an 
easy-to-use, high-performance programming interface for sharing and 
publishing live data in measurement and automation applications. You can 
use DataSocket VIs to obtain data from other DataSocket servers, Lookout 
or LabVIEW DSC module applications, and data published by the Publish 
Data VIs.

DataSocket uses uniform resource locators (URLs) to specify absolute 
paths to data items. A URL consists of three separate components: 
protocol, network address, and locator. You are probably most familiar with 
URLs from using a Web browser. For example, http://www.ni.com/
support/fieldpoint is a URL in which http is the protocol, 
www.ni.com is the network address, and support/fieldpoint is 
the locator.

In LabVIEW, select NI Measurements»FieldPoint»Advanced»
DataSocket»DataSocket Select URL. Run the VI. Enter the IP address 
of the FieldPoint network module in the Browse host field, then click 
Refresh. Browse to the data item. Copy the URL of the item and paste 
it into a string control or a constant in your LabVIEW VI. Wire the control 
or the constant to the DataSocket VI URL terminal.

DataSocket URLs for Compact FieldPoint I/O Modules
The following is an example of a DataSocket URL that points to a specific 
channel of a Compact FieldPoint I/O module:

fieldpoint:\\130.164.44.8\FP\1AI\01

In this URL, fieldpoint is the protocol, 130.164.44.8 is the IP address 
of the Compact FieldPoint controller, and FP\1AI\01 is the locator. You 
can use fieldpoint, lookout, or logos as the protocol.

The FieldPoint Process part of a URL provides the parent folder from 
which you access all data items in a Compact FieldPoint system. The 
FieldPoint Process part of a URL has the following format:

\\[machine]\FP

where [machine] is the IP address or hostname of the Compact FieldPoint 
controller.
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The I/O Module Folder part of a URL provides the sub-folder from which 
you access all data items from a specific FieldPoint I/O module. The I/O 
Module Folder part of a URL has the following format:

\\[machine]\FP\[n]

where[n] consists of the numeric address and name of the I/O module. The 
address of the I/O module is an integer from 1 to 8, where 1 represents the 
I/O module closest to the network module and 8 represents the I/O module 
farthest from the network module. The folder \\130.164.44.8\FP\1AI 
indicates the I/O module closest to the network module, and the AI means 
that it is an analog input module.

The Channel Data part of a URL provides the scaled data value of the input 
or output value for a specific channel. The Channel Data part of a URL has 
the following format:

\\[machine]\FP\[n]\[channel]

where [channel] is a two-digit decimal number between 00 and 15.

The following figure shows a DataSocket URL with Channel Data.

The locator is read as channel 0 (00) of the analog input module in slot 1 
(the slot closest to the controller) of the backplane.

Publish Data VI
You can use the Publish Data VI on the FieldPoint palette to create items 
and groups that are published using the National Instruments Ethernet 
(Logos) protocol. A host computer or cFP-21xx can link to these items 
using DataSocket or using the native connection capabilities of Lookout 
or the LabVIEW DSC module. The Publish Data VI creates data that other 
VIs and applications can browse and read, write, or read/write from the 
cFP-21xx. These items are accessible in MAX and the FieldPoint OPC 
server.
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Serial VIs
You can use the LabVIEW Serial VIs to communicate with other serial 
devices through the serial port(s) on the cFP-21xx. For more information 
about the cFP-21xx serial port(s), refer to the Serial Ports section of 
Chapter 3, Feature Descriptions.

TCP and UDP VIs
You can use the LabVIEW TCP VIs to publish data from the cFP-21xx to 
computers or devices on the network using TCP-based protocols. You can 
use the LabVIEW UDP VIs to publish data from the cFP-21xx to computers 
on the network using UDP (User Datagram Protocol).

Note The TCP and UDP VIs provide low-level access to your network. Use them only 
when the supplied protocols do not fit into your application.
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A
Troubleshooting

This appendix gives troubleshooting instructions for the cFP-21xx and 
FieldPoint software. For more troubleshooting information, refer to the 
Measurement & Automation Explorer Help for FieldPoint and the 
Measurement & Automation Explorer Remote Systems Help.

Runaway Startup Application
If a runaway startup application causes the cFP-21xx to become 
unresponsive, you must power down the cFP-21xx, then reboot it with 
either the DISABLE VI switch or the SAFE MODE switch in the ON 
position. Rebooting the controller with the DISABLE VI switch ON 
prevents any VIs from running at startup. Rebooting with the SAFE MODE 
switch ON starts the cFP-21xx in safe mode, and the embedded LabVIEW 
Real-Time engine is not launched. Refer to the DIP Switches section of 
Chapter 3, Feature Descriptions, for more information about these DIP 
switches.

STATUS LED Error Indications
The cFP-21xx indicates specific error conditions by flashing the red 
STATUS LED a specific number of times. Table A-1 describes the 
STATUS LED flashing sequences and the corresponding error condition.

Table A-1.  STATUS LED Flashes and Corresponding Error Conditions

Number 
of Flashes Error Condition

0 (stays lit) The cFP-21xx did not power on correctly. Contact 
National Instruments for assistance.

1 The cFP-21xx is in reset mode or is unconfigured. Make 
sure the RESET IP switch is in the OFF position and 
restart the controller. Refer to the Measurement & 
Automation Explorer Help for FieldPoint for more 
information about configuration.
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Other Indications of Trouble with the Controller

• Red status LED stays lit when controller is in normal mode

• Cannot detect controller in MAX unless it is in safe mode

• After youset the IP address, the controller reboots unconfigured or 
with the old IP address

• Red status LED error code greater than 3

• Red status LED error code 2 during normal operation

• Controller incorrectly reports that the disk is full

• I/O module ready LEDs off in normal mode but on in safe mode

• Unusual file or folder names when you FTP to the controller

First, use MAX to reinstall software on the controller. If that does not solve 
the problem, you may have to reformat the internal memory of the 
controller.

Reformatting the Internal Memory
1. Reboot the controller into safe mode by flipping DIP switch 7 and 

cycling the power.

2. Open MAX and expand Remote Systems to find the FieldPoint bank.

3. Right-click the FieldPoint bank and select Format Disk.

2 The cFP-21xx has detected an error in software. This 
usually occurs when an attempt to upgrade the software 
is interrupted. Repeat the software upgrade process.

3 The cFP-21xx is in safe mode. Either the controller is 
ready for software installation or the SAFE MODE 
switch is in the ON position.

4 (or more) The cFP-21xx has detected an unrecoverable error. 
Contact National Instruments for assistance.

Table A-1.  STATUS LED Flashes and Corresponding Error Conditions (Continued)

Number 
of Flashes Error Condition



Appendix A Troubleshooting

© National Instruments Corporation A-3 cFP-21xx and cFP-BP-x User Manual

If the Format Disk option is not available, there are three possible issues. 
Either the OS has not been updated, MAX 3.1 or later has not been 
installed, or MAX has not been rebooted since the controller OS was 
upgraded.

After formatting, you must reconfigure network settings and reinstall 
software. Remember to install LabVIEW Real-Time  6.1.3 or later on the 
controller, because previous versions do not work with the controller.
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B
Specifications

The following specifications are typical for the range –40 to 70 °C unless 
otherwise noted. Specifications are subject to change without notice. 

Network
Network interface................................... 10BaseT and 

100BaseTX Ethernet

Compatibility ......................................... IEEE802.3

Communication rates ............................. 10 Mbps, 100 Mbps, 
auto-negotiated

Maximum cabling distance .................... 100 m/segment

Maximum power to connected 
I/O modules............................................ 9 W

Maximum number of banks ................... Determined by network topology

Memory
cFP-2100 ................................................ 64 MB nonvolatile

64 MB DRAM

cFP-2110 ................................................ 64 MB nonvolatile
128 MB DRAM

cFP-2120 ................................................ 128 MB nonvolatile
128 MB DRAM

Memory lifetime (nonvolatile)............... 300,000 writes per sector

Serial Ports
cFP-2100 ................................................ One RS-232 serial port

cFP-2110 ................................................ Two RS-232 serial ports
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cFP-2120.................................................Three RS-232 serial ports, 
one RS-485 serial port

RS-232 (DTE) serial ports

Baud rate..........................................110–115,200 bps

Data bits...........................................5, 6, 7, 8

Stop bits ...........................................1, 1.5, 2

Parity................................................Odd, Even, Mark, Space

Flow control.....................................RTS/CTS, XON/XOFF, 
DTR/DSR

RS-485 (DTE) ports

Baud rate..........................................110–115,200 bps

Data bits...........................................5, 6, 7, 8

Stop bits ...........................................1, 1.5, 2

Parity................................................Odd, Even, Mark, Space

Flow control.....................................XON/XOFF

Wire mode .......................................4-wire

Isolation voltage

Maximum continuous
isolation voltage .......................100 Vrms

Dielectric withstand..................740 Vrms, 1 minute

Power Requirements
Power supply range ................................11–30 VDC

Recommended power supply

cFP system with 
cFP-BP-4 backplane ........................24 VDC, 15 W

cFP system with 
cFP-BP-8 backplane ........................24 VDC, 20 W

Power consumption

cFP-2100..........................................4.8 W + 1.1(Total Power 
Consumption of All I/O Modules)

cFP-2110..........................................5.0 W + 1.1(Total Power 
Consumption of All I/O Modules)

cFP-2120..........................................6.1 W + 1.1(Total Power 
Consumption of All I/O Modules)
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Physical Characteristics
Screw-terminal wiring............................ 16–26 AWG copper conductor 

wire with 7 mm (0.28 in.) of 
insulation stripped from the end

Torque for screw terminals .................... 0.5–0.6 N ⋅ m (4.4–5.3 lb ⋅ in.)

Weight .................................................... 278 g (9.8 oz)

Environmental
FieldPoint modules are intended for indoor use only. For outdoor use, they 
must be placed inside a suitable enclosure.

Operating temperature ............................ –40 to 70 °C in correct orientation;
–40 to 60 °C in other orientations

Storage temperature ............................... –40 to 85 °C

Humidity ................................................ 10 to 90% RH, noncondensing

Maximum altitude .................................. 2,000 m

Pollution Degree .................................... 2

Shock and Vibration
Operating vibration, random
(IEC 60068-2-64) ................................... 10–500 Hz, 5 grms

Operating vibration, sinusoidal
(IEC 60068-2-6) ..................................... 10–500 Hz, 5 g
(IEC 60068-2-64) ................................... 10–500 Hz, 5 grms

Operating shock
(IEC 60068-2-27) ................................... 50 g, 3 ms half sine, 

18 shocks at 6 orientations;
30 g, 11 ms half sine, 
18 shocks at 6 orientations



Appendix B Specifications

cFP-21xx and cFP-BP-x User Manual B-4 ni.com

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, and 
laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1

• CAN/CSA-C22.2 No. 61010-1

Note For UL and other safety certifications, refer to the product label, or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m 

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 
Table 1 (Industrial Levels)

CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.



Appendix B Specifications

© National Instruments Corporation B-5 cFP-21xx and cFP-BP-x User Manual

Cabling
Table B-1 shows the standard Ethernet cable wiring connections for both 
normal and crossover cables.

Figure B-1 shows the connector pinouts for FieldPoint Ethernet cables.
 

Figure B-1.  Ethernet Cable Pinout

Table B-1.  Ethernet Cable Wiring Connections

Pin Connector 1
Connector 2

(Normal)
Connector 2
(Crossover)

1 white/orange white/orange white/green

2 orange orange green

3 white/green white/green white/orange

4 blue blue blue

5 white/blue white/blue white/blue

6 green green orange

7 white/brown white/brown white/brown

8 brown brown brown

Connector 1 Connector 2

pin 1 pin 1 pin 8pin 8
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C
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Developer Exchange at 
ni.com/exchange. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
the manufacturer’s declaration of conformity. This system affords 
the user protection for electronic compatibility (EMC) and product 
safety. You can obtain the DoC for your product by visiting 
ni.com/certification.
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• Calibration Certificate—If your product supports calibration, 
you can obtain the calibration certificate for your product at 
ni.com/calibration.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

m milli 10–3

k kilo 103

M mega 106

% Percent.

° Degrees.

Ω Ohms.

0x Precedes a hexadecimal number.

b Bits.

B Bytes.

bank The combination of one FieldPoint network module and one or more 
terminal bases and I/O modules.

C Celsius.

DIP switch Dual inline package switch.

DNS Domain name server.

FTP File Transfer Protocol.

HotPnP Hot plug-and-play.

I/O Input/output.

IEC International Electrotechnical Commission.

LED Light-emitting diode.

m Meters.

OPC OLE for Process Control.

PG Pulse generation. 

POST Power-on self test.
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PWM Pulse-width modulation. Generation of a pulse waveform with fixed 
frequency and variable pulse width (duty cycle). PWM is used to control 
discrete devices such as DC motors and heaters by varying the pulse width 
(the ration of on time to off time).

subnet A set of systems whose IP addresses are configured such that they can 
communicate directly with one another. Data will not flow through an 
intermediate router.

TCP Transmission Control Protocol. A set of standard protocols for 
communicating across a single network or interconnected set of networks. 
TCP is for high-reliability transmissions.

UDP User Datagram Protocol. A set of standard protocols for communicating 
across a single network or interconnected set of networks. UDP is for 
low-overhead transmissions.

V Volts.

VDC Volts direct current.

VI Virtual Instrument. A combination of hardware and/or software elements, 
typically used with a PC, that has the functionality of a classic stand-alone 
instrument.

W Watts.
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Index

Numerics
100 Mbps LED, 3-4
10-position modular jack

pin descriptions (table), 3-9
pin locations (figure), 3-8

A
A LED, 3-4
Application Builder

Application Settings tab, 4-10
embedding LabVIEW VIs on cFP-21xx, 4-8
Installer Settings tab, 4-10
Source Files tab, 4-10
Target tab, 4-9
VI Settings tab, 4-10

applications, embedded. See embedded 
applications on cFP-21xx

B
B LED, 3-4

C
C LED, 3-4
cables, Ethernet, 2-16, B-5
calibration certificate (NI resources), C-2
cFP-2120, 3-9, 3-10, 3-11

compact flash, 3-11
cFP-21xx

overview, 1-1
setup overview, 1-3

cFP-21xx controller
configurable power-up states, 3-2
data communication methods, 5-3

embedded applications. See embedded 
applications on cFP-20xx

limiting host access to LabVIEW Real-Time 
engine, 4-4

network watchdog, 3-1
powering up, 2-17
snapshot feature, 3-2
targeting LabVIEW Real-Time to 

cFP-21xx, 4-1
transferring files to and from cFP-21xx, 3-12
using from PC applications

LabVIEW, 5-1
LabVIEW TCP and UDP VIs, 5-6
LabWindows/CVI, 5-1
OPC server, 5-2
overview, 5-1

using with from PC applications
DataSocket communication, 5-4
LabVIEW Publish Data VI, 5-5
LabVIEW serial VIs, 5-6

cFP-21xx hardware
cleaning, 2-2
connecting to network, 2-16
DIP switches, 3-5
figure, 1-2, 2-5, 2-13
hot swapping, 3-2
installation, mounting cFP-21xx in rack, 2-8
power source, 3-11
powering, 2-16
RS-232 serial port, 3-7
specifications, B-1

cFP-BP-x, figure, 2-5
cleaning cFP-21xx, 2-2
Compact FieldPoint

safety information, 2-2
system (definition), 1-2
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configuration
connecting to field devices, 2-14
custom power-up configuration, 3-2
hot swapping, 3-2
overview, 1-3

conventions used in the manual, iv

D
D LED, 3-4
data communication

100 Mbps LED, 3-4
methods, 5-3

DataSocket, 5-4
DataSocket data communication, 5-4
DB-9

pin descriptions (table), 3-7
pin locations (figure), 3-7

Declaration of Conformity (NI resources), C-1
diagnostic tools (NI resources), C-1
digital input/output, 3-9, 3-10, 3-11
DIN rail mount. See installation, mounting 

hardware on DIN rail
DIO, 3-9, 3-10, 3-11
DIP switches, 3-5
DISABLE VI switch, 3-6
documentation (NI resources), C-1
downloading

files to cFP-21xx, 3-12
LabVIEW VIs to cFP-21xx, 4-6

drivers (NI resources), C-1

E
embedded applications on cFP-21xx, 3-1, 4-8, 

4-10, A-1
environmental specifications, B-3
errors

runaway startup application, A-1
STATUS LED, 3-3

error indications (table), A-1

Ethernet network
cable length (caution), 2-16
cabling connections (table), B-5
connecting cFP-21xx to network, 2-16
connections

LINK LED indicator, 3-3
methods, 2-16

Ethernet port, 1-2, 2-4, 2-5, 2-13
examples (NI resources), C-1

F
FieldPoint software

See also MAX
configuration, 2-18
FTP download site, 1-3
installation, 2-18
OPC server, 5-2
overview, 1-3

FieldPoint VIs, 5-1
file transfer capability, 3-12
FTP

National Instruments FTP site, 1-3
RT Engine FTP server, 3-12

H
hardware, installation

mounting backplane on DIN rail, 2-11
mounting on panel, 2-6

help, technical support, C-1

I
I/O modules

configurable power-up state, 3-2
configuration after replacement 

(table), 3-3
connecting to field devices, 2-14
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inserting, 3-2
installing on backplanes, 2-13, 2-15
powering, 2-16
removing, 2-14, 2-15, 3-2
replacing, 3-2

installation
connecting to network, 2-16
FieldPoint software, 2-18
hot swapping, 3-2
installing cFP-21xx controller on 

backplane, 2-13
installing I/O modules on backplane, 

2-13, 2-15
LabVIEW Real-Time, 2-18
mounting hardware in rack

mounting backplane, 2-8
rack-mount accessory, 2-8

figures, 2-9
mounting hardware on DIN rail

fastening DIN rail clip to 
backplane, 2-11

mounting backplane on DIN 
rail, 2-11

mounting hardware on panel
panel-mount accessory, 2-6

mounting hardware to panel
panel-mount accessory (figure), 2-7

overview, 1-3
power connections, 2-16
removing I/O modules, 2-14, 2-15

installation category, 2-3
Installer Settings tab in Application 

Builder, 4-10
instrument drivers (NI resources), C-1
IP address, resetting with Reset switch, 3-7
isolation, defeated by cascading power 

(caution), 2-17

K
KnowledgeBase, C-1

L
LabVIEW Real-Time

disabling engine with Safe Mode 
switch, 3-6

network options, 4-3
programming, 4-1
Real-Time Engine, 1-1, 3-6, 3-12, 4-3, 4-8
RT Target Access options, 4-4
RT Target Miscellaneous options, 4-6
targeting LabVIEW Real-Time

to a platform, 4-1
to host PC, 4-3

LabVIEW RT
See also Application Builder
embedded applications. See embedded 

applications on cFP-21xx
LabVIEW VIs

Disable VI switch, 3-6
embedded applications. See embedded 

applications on cFP-21xx
FieldPoint VIs, 5-1
launching VIs at system startup, 4-6, 4-10
Publish Data VI, 5-5
runaway startup applications, A-1
serial VIs, 5-6
specifying download path, 4-6
specifying target with command line 

arguments, 4-8
TCP, 5-6
UDP VIs, 5-6

LabWindows/CVI software, 5-1
LED indicators, 1-2, 2-4, 2-5, 2-13, 3-3

power-on self test (POST), 2-17, 3-4
LED output, 3-9, 3-10, 3-11
LINK LED, 3-3
local bus connector, 1-2, 2-4, 2-5, 2-13
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M
MAX

configuration, 2-18
installation, 2-18

100 Mbps LED, 3-4
memory specifications, B-1
modular jack connector

pin descriptions (table), 3-9
pin locations (figure), 3-8

mounting hardware in rack
See also installation, mounting hardware 

in rack
mounting backplane, 2-8
rack-mount accessory, 2-8

figures, 2-9
mounting hardware on DIN rail. See 

installation, mounting hardware on DIN rail
mounting hardware to panel. See installation, 

mounting hardware to panel
mounting, figure, 2-4

N
National Instruments support and 

services, C-1
network specifications, B-1
network watchdog, 3-1

O
OPC

client, 5-2
server, 5-2

orientation, 2-4
overview

cFP-21xx, 1-1
FieldPoint software, 1-3
setup, 1-3
using cFP-21xx from PC applications, 5-1

P
panel mount. See installation, mounting 

hardware on panel
physical characteristic specifications, B-3
pin descriptions, DB-9

connector pin descriptions, (table), 3-7
connector pin locations, (figure), 3-7

pollution degree, 2-2
power connections, wiring, 2-16
power connector, 1-2, 2-4, 2-5, 2-13, 3-11
POWER LED, 3-3
power requirements specifications, B-2
power supply, 2-16
power-on self test (POST), 2-17, 3-4
power-up

launching LabVIEW Real-Time 
applications at system startup, 4-6, 4-10

overview, 2-17
runaway startup applications, A-1

power-up states, configurable, 3-2
programming examples (NI resources), C-1

R
rack mount. See installation, mounting 

hardware in rack
rail clip, 1-2, 2-4, 2-5, 2-11, 2-13
registering computers, with OPC, 5-2
removable compact flash, 3-11
RESET IP switch, 3-7
resetting a FieldPoint bank, 3-7
RS-232 serial port, 1-1, 2-4, 2-5, 2-13, 3-7, 5-6
RS-485 serial port, 3-7
RT Engine. See LabVIEW RT; RT Engine
RT Target Access options, 4-4
RT Target Miscellaneous options, 4-6
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S
safe mode, 3-6
SAFE MODE switch, 3-6
safety information, 2-2
saving current state of FieldPoint bank, 3-2
serial data communication, 5-6
serial port, 1-1, 3-7, 5-6
serial VIs, 3-7
setup, 1-3

overview, 2-1
snapshot feature, 3-2
software (NI resources), C-1
specifications

cables, B-5
CE compliance, B-4
electromagnetic compatibility, B-4
environmental, B-3
memory, B-1
network, B-1
physical characteristics, B-3
power requirements, B-2
safety, B-4
serial ports, B-1
shock and vibration, B-3

STATUS LED, 3-3
error indications (table), A-1

switch input, 3-9, 3-10, 3-11
switches, DIP switches, 3-5

T
TCP data communication, 5-6
technical support, C-1
terminal bases, powering, 2-16
testing, power-on self test (POST), 3-4
training and certification (NI resources), C-1
troubleshooting

NI resources, C-1
runaway startup applications, A-1
STATUS LED error indications 

(table), A-1

U
UDP data communication, 5-6

V
VIs. See LabVIEW VIs

W
watchdog, 3-1
Web resources, C-1
wiring

diagrams, 3-9, 3-11
Ethernet cables, B-5
Ethernet connections, 2-16
field devices, 2-14
power, 2-16
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